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Tips
Tip of the Day 1- FlashForge Dreamer Lights
Posted: Tue Jan 13, 2015 3:35 pm
by KeyboardWarrior
The FlashForge Dreamer uses G-Code to control the RGB lights. The G-Code line for the default
profiles is highlighted in the picture below which is for the Starting G-Code in the process settings
window. The lights are set to red for preheating and off for the print, but I personally like to print with
the lights on max so I set the zero's to 255 for each of them. 0 is off, 255 is max for each RGB value.
M146 r255 g255 b255; max lights
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Tip of the Day 2- Save time, faster print settings
Posted: Wed Jan 14, 2015 9:38 am
There are a few ways to get faster prints in Simplify3D, using all of them in conjunction definitely
stacks the positive benefits and really help reduce the time it takes for prints!
1.Using Sparse Infill/Sparse Support:
I've grouped Sparse Infill and Sparse Support together since the idea is the same for the both of them.
This feature is especially helpful to users who are printing with .2 mm layer height or finer.
For instance, if you are printing with a .1 mm layer height (fine resolution for details), it doesn't make
sense that you would need to print the infill, the part that no one can see at such fine resolution. The
standard method of printing goes as follows:
Layer 1:perimeter-->infill
Layer 2:perimeter-->infill
Layer 3:perimeter-->infill
Layer 4:perimeter-->infill
...
You could optimize this and have the following order:
Layer 1:perimeter
Layer 2:perimeter
Layer 3:perimeter-->infill (at 3x the resolution)
Layer 4:perimeter
...
Printing Sparse Infill or Sparse support can be a huge benefit on large prints that have long and tedious
tool-paths for the extruder to follow. When enabling Sparse Infill (Infill tab), or Sparse
Support(Support tab).
Setting these up depends on your printer and extruder type, my general recommendations for what
work on my printers are if you are printing at .2 mm, I would recommend printing sparse every 2
layers. If you're printing at .1 mm, I would recommend printing sparse every 3 layers for maximum
time saving.
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2.Using Thick Infill:
This may be the easiest setting listed here, under the Infill tab you can change the extrusion width %.
The software will calculate and keep your infill % the same, but you get a much more efficient toolpath
because you are laying down much more plastic per second.
For instance, with a .5 mm nozzle and .5 mm extrusion width standard. If you set an extrusion width of
150% under the Infill tab, your perimeters will be printed at .5 mm thickness and your infill will be
printed at .75 mm thickness, which will give a sturdier infill that takes less time to print, and doesn't
change the part quality.
3.Sequential printing:
If you're printing two parts on your bed 100 mm tall (approx 4 inches), at a .2 mm layer height it will
require 500 layers. With sequential printing on, you can decide you only want to move from model to
model once every 10 mm, instead of every .2 mm. If you have more parts, on a bigger bed, this feature
will be even more useful. To use this, you setup for a multi-part print by making each part have it's own
customized process, then after clicking Prepare to Print! the software will prompt you whether you'd
like to use sequential printing or continuous. http://www.simplify3d.com/support/tutorials/multi-partprinting/
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Tip of the Day 3- Steps Per MM, tolerances and more!
Posted: Thu Jan 15, 2015 1:16 am
by KeyboardWarrior
Printing with tolerances can be tough. There are settings in the software as well as settings in your
printers firmware that may control these tolerances. If you have a prototype that needs to fit with other
parts, or you want to make something fits with a certain part, it can be frustrating when your part comes
out skewed. There are two different sections in todays Tip, "Off by a large margin" and "Off by a small
margin". If you're printing 20 mm calibration cubes and finding that your measurements are 20.5 mm
or larger in the X-Y or Z direction, I would definitely recommend starting off in the "Off by a large
margin" category first!
Off by a large margin
If your print is off by a large margin, in the X-Y or even Z- axis, it points to one thing. Steps-per-mm
values. When the G-Code Simplify3D makes is sent to your printers firmware, your printer uses your
Steps-per-mm values to decide how much to turn the stepper motor to move one mm. If the Steps-permm value is off, than you will get parts that are not to scale.
If you are using a RepRap style printer, you can open the Configuration.H file of the firmware in
Arduino and find the steps-per-mm values there. For MakerBot/Sailfish style printers, you will need to
use a custom GPX ini file in your Simplify3D folder and reference it using the post processing script
option in Simplify3D which is a bit more invovled.
My recommendation for calibrating Steps per mm if necessary is to do the following:
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1) Print a 20 mm cube
2) Measure the cube with calipers
http://www.amazon.com/Inch-Digital-Caliper-ExtraBattery/dp/B0002JFMIO/ref=lp_256411011_1_1?s=industrial&ie=UTF8&qid=1421300848&sr=1-1
3) Use this formula for correction for the axis you'd like to calibrate. This formula is simply for a 20
mm cube, using cross multiplication to find the Corrected Steps per mm value
CorrectedStepsPerMMValue = (20 mm*CurrentStepsPerMMValue)/(MeasuredSide)
4) Use new StepsPerMM values and reprint the 20 mm cube to validate results!

Quick and Dirty Fix: If you don't want to change your printers firmware or use a custom gpx file, and
you need correct tolerances NOW for a deadline. Just use the formula below and then double click your
part and scale it accordingly in the X-Y and Z-axis. (Not recommended, but it would most likely be a
good enough temporary solution)
Scaling= CorrectSideLength/PrintedSideLength
Off by a small margin
Small margins can be tough! Since any number of factors may be at play.
-If your extrusion multiplier is too high, your outer perimeters could be about too thick and lead to
tolerancing issues due to that
-Warping due to too much heat could cause your outer perimeters to lose their shape
-Print speed may be too high
Ensuring your extrusion multiplier isn't too high and also remembering not to print at a speed higher
than your printer can handle are great starting points for small margins.
Also, if shifting is causing your parts to be off:
-If your belts are too loose, the motor could be turning and not turning the belt with it
-If your belts are too tight, the motor could be turning and once again, not turning the belt with it
-The voltage to the stepper motors may be off

To Conclude
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I think changing and using the formula for Steps-per-mm values and working with those is very
important. For small margins, you're really just changing general printing settings, that would affect
many aspects of your print, not just size. If your extrusion multiplier is off, you'll probably see it in
more spots than just the tolerancing of your part. Really calibrating and setting your Steps-per-mm
value absolutely right and as close to as possible as your calipers will let you can provide amazing
results and really take your printing to the next level.
From a CAD/design stand-point, Make Magazine has a good article with a section designated for this
exact topic which I've pasted below.
http://makezine.com/2013/12/11/top-ten-tips-designing-models-for-3d-printing/
FIT TOLERANCES FOR INTERLOCKING PARTS
For objects with multiple interlocking parts, design in your fit tolerance. Getting tolerances correct can
be difficult. Kacie’s tips for creating correct tolerances: use a 0.2mm offset for tight fit (press fit parts,
connecters) and use a 0.4mm offset for lose fit (hinges, box lids). You will have to test it yourself with
your particular model to determine what is the right tolerance for the thing you are creating.
Re: Tip of the Day 3- Steps Per MM, tolerances and more!
Posted: Thu Jan 15, 2015 8:12 am
by TenKOhms
Great tips KBW, I'm sure they're going to help a lot of people out.
For RepRap style machines, if you use the machine control panel to send in manual commands, send in
the command M503
With some firmwares, this will give you a printout of your printer's saved EEPROM values, or values
that are loaded when the printer is power-cycled. If it displays your steps per mm you can use the
command:
M92 X?? Y?? Z?? E??
(replace ?? with respective axis steps/mm)

This will change your printer's current steps/mm, but the values will be reverted back to EEPROM
values on a power cycle. After doing the M92 command you can do:
M500

to save these new steps per mm to your printers EEPROM so that even with a power cycle it will be
retained.

In terms of adjusting steps per mm for calibrating printed dimensions, this is usually seen as a more
legacy method used back when the RepRap project were using printed pulleys that aren't as accurate as
Page 8 of 77

the aluminum GT pulleys we use today. Because of this, back when the pulleys were printed and
difficult to print the teeth pitch correctly, the
steps per mm * desired value/measured value was used.
With our new hardware, however, with the more accurate aluminum pulleys with accurate pitches and
what not, it's actually better to use a calculated steps per mm value based off of hardware, and then
calibrate your print dimensions with settings such as extrusion multiplier, measuring actual filament
diameter, etc. This will give you much more accurate prints in the long run when you have inner
features such as screw holes or scale prints to print larger
Re: Tip of the Day 3- Steps Per MM, tolerances and more!
Posted: Thu Jan 15, 2015 8:36 am
by habloIngles
look forward to reading these everyday good job mate. Gonna have to check back regularly so I don't
miss one before it gets lost into the forray
Re: Tip of the Day 3- Steps Per MM, tolerances and more!
Posted: Thu Jan 15, 2015 8:38 am
by BaudR8
the dreaded and infamous steps per millimeter
Re: Tip of the Day 3- Steps Per MM, tolerances and more!
Posted: Thu Jan 15, 2015 11:02 am
by dsegel
One thing to consider is that while the cheap digital calipers like those your linked to have a resolution
of (i.e. will READ a dimension to) 0.01mm, they are not accurate to that degree. Most are only
accurate to about 0.02mm - 0.03mm. So don't go crazy chasing perfection.
To get more accuracy you need to spend hundreds of dollars more.
Re: Tip of the Day 3- Steps Per MM, tolerances and more!
Posted: Thu Jan 15, 2015 11:25 am
by KeyboardWarrior
TenKOhms wrote:Great tips KBW, I'm sure they're going to help a lot of people out.
For RepRap style machines, if you use the machine control panel to send in manual
commands, send in the command M503
With some firmwares, this will give you a printout of your printer's saved EEPROM values,
or values that are loaded when the printer is power-cycled. If it displays your steps per mm
you can use the command:
M92 X?? Y?? Z?? E??
(replace ?? with respective axis steps/mm)
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This will change your printer's current steps/mm, but the values will be reverted back to
EEPROM values on a power cycle. After doing the M92 command you can do:
M500

to save these new steps per mm to your printers EEPROM so that even with a power cycle
it will be retained.

In terms of adjusting steps per mm for calibrating printed dimensions, this is usually seen
as a more legacy method used back when the RepRap project were using printed pulleys
that aren't as accurate as the aluminum GT pulleys we use today. Because of this, back
when the pulleys were printed and difficult to print the teeth pitch correctly, the
steps per mm * desired value/measured value was used.
With our new hardware, however, with the more accurate aluminum pulleys with accurate
pitches and what not, it's actually better to use a calculated steps per mm value based off of
hardware, and then calibrate your print dimensions with settings such as extrusion
multiplier, measuring actual filament diameter, etc. This will give you much more accurate
prints in the long run when you have inner features such as screw holes or scale prints to
print larger

Definitely a great idea about the G-Code commands to get the steps-per-mm values. I also 100% agree
that with most printers you purchase today, the hardware will come pretty spot on. However, for many
who built their own printer, modified designs, or received printers that weren't properly calibrated
you're most likely going to need to modify your steps per mm values.
dsegel wrote:One thing to consider is that while the cheap digital calipers like those your
linked to have a resolution of (i.e. will READ a dimension to) 0.01mm, they are not
accurate to that degree. Most are only accurate to about 0.02mm - 0.03mm. So don't go
crazy chasing perfection.
To get more accuracy you need to spend hundreds of dollars more.

Great point! I think if you're printing within +- .2 mm (about 10x the error of the calipers) that those are
great results for current FDM printers. However, some users with more advanced prototyping needs
may need to be more precise.

Tip of the Day 4- Layer tab, a technical analysis
Posted: Thu Jan 15, 2015 2:46 pm
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by KeyboardWarrior
Today's tip is more of a glossary of terms for the Layer tab. If you guys have anything to add, please
feel free to add a comment below.
Layer Tab
Primary Extruder: Which extruder you'd like to have the Perimeters printed with.
Primary Layer Height: How thick you want each layer to be on the Z-axis. Smaller means finer
resolution and better print quality, but also means many more layers you'll have to print, which can
dramatically increase print time.
Most profiles use the following:
Fast prints: .3 mm
Medium: .2 mm
High Quality: .1 mm
Top Solid Layers: The number of 100% infill layers that will be placed at the top of your part. If you
notice that there's some incomplete filling your top layers, I would recommend raising this value from
3 to 5 and increasing the extrusion multiplier slightly under the Extruder tab if needed.
Bottom Solid Layers: The number of 100% infill layers that will be placed at the bottom of your part.
Outline/Perimeter Shells: Outline shells will trace the outline of your part, and extrude at your
extrusion thickness. The printer will print the outline shells, then print Infill afterwards. I traditionally
print with 2 Outline Shells.
Outline Direction; Inside-Out: It will print your perimeter shells from the inner shell to the outer most
shell. This is very beneficial when printing overhangs, as the print is branching out in the X-Y direction
for each layer.
Outline Direction; Outside-In; It will print your perimeter shells from the outer most shell to the inner
most shell. This is better for surface quality finish usually. For instance, if printing a cube, this may be
the better route.
Print Islands Sequentially without optimization: Lets say you are printing the part below. If you went
from pillar to pillar in the most efficient order, you may get to the next layer so quickly there may be
issues with heat-build up and the previous layer not being solidified. Therefore, you can turn off
optimization, and then it will print the pillars in a random-order therefore helping you prevent from
heat-build up.
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Single outline corkscrew printing mode (vase mode): The extruder will print with one outline/perimeter
shell and won't make any retracts. This means that it will slowly move up in the Z as it prints, imagine
spiraling upwards, instead of printing a static layer, than moving upwards to do another layer.
Traditionally with vases the best settings I've found are Zero top solid layers, 3 Bottom Solid Layers,
and under the Advanced tab enable "Merge all outlines into a single solid model".
First Layer Settings (These are applied to where the Bed touches your model. If you have a raft, that
means the First Layer Settings will apply to your raft).
First Layer Height: This % will take a % of your Primary Layer Height. If you are printing with a small
Primary Layer Height like .1 mm I would recommend a First Layer Height of 250%, to get about a
resulting .25 mm first layer height
If your First Layer Height is below 100%, the extrusion amount will remain the same, only the Z-will
change, but if you increase above 100%, the extrusion amount will scale accordingly.
First Layer Width: the extrusion width of your first layer, you may find that your first layer sticks better
with a thicker extrusion (100%+). I don't have too much experience with this, but I think 125% or
150% would be good starting points.
First Layer Speed: Slows down the First Layer Speed to a percentage of your Default Printing Speed
(Other tab)
Start Points: Certain printers find that there are very small voids at the starting points. This can create
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a seam on the print. Start points can options can help for both controlling where these voids (the seam)
goes, but also help for print time.
Use Random Start Points for all perimeters: Randomizes the starting points
Optimize Start points for fastest printing speed: Optimizes starting points by finding the closest
location for the next starting point. When generating G-Code you can see the travel moves,
traditionally this option really minimizes the amount of red lines that signify travel moves you will see
on the G-Code previewer
Choose start points closest to specific location: This can be useful if you want to line-up your starting
points on a certain part of your print, so the seam isn't obvious or is hidden.
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Tip of the Day 5- Firmware Configuration
Posted: Fri Jan 16, 2015 8:54 am
by KeyboardWarrior
Firmware Configuration is very important, it basically tells Simplify3D what "flavor" of G-Code to
make and what kind of X3G file to make (if necessary). This is set automatically by the software
through the Configuration Assistant. However,when you have multiple printers you switch back-andforth from, you may not be going through the Configuration Assistant every time you switch, which
means you should probably ensure your firmware Configuration is right.
For Sailfish style machines
For RepRap style machines
As long as your properly set to RepRap style for a RepRap printer, you shouldn't have an issue. If you
are set to the wrong Firmware Configuration you might notice your bed not waiting to heat up, fans not
turning on, and tool-head switches not going through.

for MakerBot/Sailfish style machines (5th Gen MakerBots use RepRap Firmware Configuration)
Having the correct profile is important, but with MakerBot/Saiffish Firmware Configuration, the X3G
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setting the Machine Profile is really important!
For instance a common occurrence of wrong Machine Profile for MakerBot style printers, If you're
using a Replicator 1-dual style printer, (FF Creator/CreatorPro,Wanhao Duplicator, PowerSpec, etc),
but have it set on the default Replicator 2 profile you'll have the following symptoms:
Your heated bed won't work. (Replicator 2 doesn't have a heated bed)
You won't be able to use your left extruder. (Replicator 2 doesn't have a left extruder)
Your parts will be about 7% too small. (Replicator 2 uses different Steps-Per-MM values)

Example of practical use
For instance, if you use a FlashForge Creator Pro printer and a custom delta machine:
FlashForge Creator Pro-- MakerBot/Sailfish firmware with Replicator 1-dual extruder selected under
the X3G tab
Custom Delta Machine-- RepRap firmware
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When switching process settings from one to the other, it's very important to also go in to your
Firmware Configuration and set that as well, otherwise you'll have a whole host of problems.
Conclusion
This generally applies to people with more than one printer, since single printer users can traditionally
use the Configuration Assistant on the printer they have the first time through the software, and that
will set the Firmware Configuration. However, if you're constantly switching printers, and are a
printing enthusiast then it's vital to know this!
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Tip of the Day 6- General Troubleshooting Simplify3D
Posted: Sat Jan 17, 2015 10:21 pm
by KeyboardWarrior
These are some common things/subjects that I feel come up, or things that I've experienced and wanted
to share.
Printer won't connect to Simplify3D
1) Check Baud Rate to be sure. Generally 115200, or 250000 for most printers. Some printers use other
Baud Rates, this information should come with your printer.
2) Ensure USB drivers are installed (If Simplify3D doesn't show your USB port for your printer,
chances are there's no driver so your computers not able to recognize the USB detection. Key test, can
you connect to the printer using a different software program?
RepRap style Arduino/Ramps board: install Arduino IDE that will install the proper drivers (Mendels,
Prusa's, RoBo 3D, anything with an Arduino Mega on it)
LeapFrog 3D printers: FTDI drivers http://www.lpfrg.com/support/installation
Ultimaker FTDI drivers: http://wiki.ultimaker.com/FTDI_Driver_installation
Rambo Board- http://reprap.org/wiki/Rambo#USB_Driver (SeeMeCNC Orion/Delta MAX, Lulzbot
Taz, Airwolf printers, MakerGear, new Mendels)
MakerBot/Sailfish- I would recommend installing ReplicatorG as that will include drivers as needed
MakerBot 5th Generation- Windows 7 and 8 may already have the necessary drivers, but if they don't
installing MakerBot Desktop should fix this.
3) (If MakerBot/Sailfish style machine) Open MakerBot Desktop, go to Services and select Stop
Background Services. Background Services will connect to the printer even if MakerBot Desktop isn't
open, so if you try to connect with Simplify3D, Simplify3D will get an error since the printer's already
connected to another piece of software!

Printing over USB, Firmware Unresponsive error in machine control panel/print stops randomly
There are a few reasons this could be happening. However, I personally avoid USB printing at all costs
as I find that the added risks of a failed print from USB cable transmission/PC issues is not worth it.
CNC machines are extremely similar to 3D printers and even run off of G-Code, however if you were
to use a USB cable to stream G-Code to your CNC machine, that would be ridiculed as terrible design.
The CNC machines I've worked with use either a flash drive or SD card for data transmission. With 3D
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printing, the stakes are a lot lower, if you lose a print due to streaming USB transmission failure from
your PC, it's potentially only a few dollars in plastic and few hours wasted. With CNC machines, it
could be a block of titanium worth 1,000 dollars being cut, so the CNC designers definitely would not
have the added risks and add chance of failure in transmission.
Reasons why computer to USB transmission should be a secondary choice to SD card printing:
Main reason-->USB cables are prone to EM interference- If too many transmissions get dropped in the
back-and-forth the firmware will go unresponsive.
Computer's sleep settings may be on
Laptop could run out of battery
Automatic system updates restarting the computer
If your processor lags (playing a video game that requires high performance)- transmission could be
interrupted
Accidentally closing the software
Computer freezing due to another program
However, if you're crashing still over SD card, one possibility is that your microprocessor is
overheating. I've had this on a Ramps Board occur, which was remedied by adding a small fan to the
power supply rails.
Upgraded to new version of the software, new profiles aren't showing up
Installing the new version, doesn't uninstall the old version, so it can be an easy mix up to accidentally
open a previous version if the shortcut on your desktop is linked to the old version or if your file
association your computer is associated with the old version.
However, if you are opening the new version of the software, this can be fixed by going to Help->Reset All Settings
(RepRap/Marlin style printers)Added an extruder to my printer, toolhead offsets are off
The firmware controls the toolhead offsets, however you can also adjust the value at the start of each
print under the Scripts tab. There's the Starting G-Code where you can add tool head offset G-Code
commands. For instance, if there's a 33 mm offset in the X direction between your right and left
extruder, place these two commands at the beginning of your starting G-Code.
M218 T0 X0 Y0;
M218 T1 X33 Y0;
(MakerBot/Sailfish) Left Extruder/Heated Bed is not working. Or print is not to size
http://www.forum.simplify3d.com/viewtopic.php?f=8&t=1944
RepRap Prints are not to size
http://www.forum.simplify3d.com/viewtopic.php?f=8&t=1937
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Tip of the Day 7- Infill tab, a technical analysis
Posted: Sun Jan 18, 2015 12:25 pm
by KeyboardWarrior
Infill tab:
A lot of the infill tab settings are

Infill Extruder: Pick which extruder you'd like to extrude the infill of your part with.
External Infill Pattern: The top and bottom solid layers will be printed with this choice. Either
Rectilinear or Concentric. Concentric infill will mimic your perimeter outlines, coming inwards. For a
cylinder, it would make smaller and smaller circles.
Rectilinear is the more common choice, it will fill in using straight lines.
Infill Fill Percentage: What % your part you'd like to be filled in.
Outline Overlap This value will dictate how far into the perimeter the infill goes. If this value was 0,
the infill would start of the perimeter and not overlap at all. At 100%, you would have complete
overlapping. Calibrating this value, I would say the average value I find that works well is 30% for the
printers I've used, but it does vary.
Infill Extrusion Width: This % will modify your extrusion width under the extruder tab for the Infill. If
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you have a .5 mm extrusion width under the Extruder tab and set a 200% Infill Extrusion Width, your
Infill will be 1 mm thick.
Minimum Infill Length: This is default set to 5 mm, if there are small sections in the G-Code previewer
that aren't filling in, you may want to set this to a lower value.
Print Sparse Infill Every __ layer(s): If you'd like to only print Infill once every 2 or every 3 layers,
then you'd place that number in the input. My experience has been that most printers can print infill at
.3 mm just fine. Therefore, if I'm at .1 mm layer height, I'll use 3 sparse layers, and if at .15 mm I'll use
2 sparse layers.
Include Solid diaphragm every __ layers: A solid diaphragm is a layer of infill at 100%. For certain
parts, this can be helpful, if you want to keep the infill % low, but also add the extra structural rigidity a
100% layer of infill can provide.
Use random Infill placement for each layer: When this option is enabled, each layer of infill will start at
a random spot. This means that the lines of infill won't line up.
I personally am a fan of keeping this option off, stacking the layers of infill on-top of each other seems
to provide stronger parts.
Infill Angles: Standard angles are 45/-45. That means that layer infill angles and external infill will
print at alternating 45 degree angles. These values traditionally don't need to be adjusted, but I'm also a
fan of using 0/45/-45/90 as the angle orientations.
Re: Tip of the Day 7- Infill tab, a technical analysis
Posted: Tue Jan 20, 2015 10:24 am
by montressor
Thanks for these, again, hugely useful. One question about the "Print Sparse Infill...": I assume using
this to skip layers *must* be used in conjunction with increasing the "Infill Fill Percentage" to ensure
the proper height of fill is being used, correct? I changed the number of layers I printed without an
according increase in the fill percentage and wound up with a bit of a mess.
Subsequent question: how big a percentage can you do here? Up to the nozzle width? e.g.: with a
0.4mm nozzle printing 0.1mm layers, I could set "Infill Fill Percentage" to 400% and set my "Print
Sparse Infill" to every 4 layers?
Re: Tip of the Day 7- Infill tab, a technical analysis
Posted: Tue Jan 20, 2015 12:08 pm
by KeyboardWarrior
montressor wrote:Thanks for these, again, hugely useful. One question about the "Print
Sparse Infill...": I assume using this to skip layers *must* be used in conjunction with
increasing the "Infill Fill Percentage" to ensure the proper height of fill is being used,
correct? I changed the number of layers I printed without an according increase in the fill
percentage and wound up with a bit of a mess.
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Subsequent question: how big a percentage can you do here? Up to the nozzle width? e.g.:
with a 0.4mm nozzle printing 0.1mm layers, I could set "Infill Fill Percentage" to 400% and
set my "Print Sparse Infill" to every 4 layers?

The software will calculate and scale the extrusion amount for the sparse feature, so you don't have to
worry about that. You'll still get your infill %, since the sparse infills will have modified extrusion
values. That is a good thought though
Re: Tip of the Day 7- Infill tab, a technical analysis
Posted: Tue Jan 20, 2015 12:49 pm
by JFettig
Infill extrusion width doesn't increase the width of infill except for where it crosses previous layers, it
increases the depth - if you use only 2 orientations(45,-45) and 200%, it will make a relatively solid
infill and not just be a pile of strings, it strengthens the part significantly, adding another angle to it
negates that and the infill isn't stacked. Using random infill placement has no use, it only has negative
effects.
Using sparse infill is also kind of pointless IMO - it extrudes more material per infill pass but only
makes infill every so many layers specified - set to 2, every 2 layers of border, it'll infill once, but twice
as much material, it'll be crude.
In my opinion, both angles the infill is laid, should be laid on the same layer to make solid infill and
have to use the extrusion width at 100% like every other slicer does it, its stronger and more reliable, it
only takes a little longer
Re: Tip of the Day 7- Infill tab, a technical analysis
Posted: Tue Jan 20, 2015 1:03 pm
by TenKOhms
JFettig wrote:Infill extrusion width doesn't increase the width of infill except for where it
crosses previous layers, it increases the depth - if you use only 2 orientations(45,-45) and
200%, it will make a relatively solid infill and not just be a pile of strings, it strengthens the
part significantly, adding another angle to it negates that and the infill isn't stacked. Using
random infill placement has no use, it only has negative effects.
Using sparse infill is also kind of pointless IMO - it extrudes more material per infill pass
but only makes infill every so many layers specified - set to 2, every 2 layers of border, it'll
infill once, but twice as much material, it'll be crude.
In my opinion, both angles the infill is laid, should be laid on the same layer to make solid
infill and have to use the extrusion width at 100% like every other slicer does it, its stronger
and more reliable, it only takes a little longer
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Increasing infill extrusion width definitely helps increase the extrusion rate of infill. I've seen a couple
pictures of a "whispy" infill vs one with increased extrusion width, and the width, solidarity, and
rigidity were noticeably different. IMO, this is one of the most useful features I've seen added.
Sparse infill is not useless, and in most cases (at least when I last checked), many of lulzbot's company
profiles (for a different slicer) use sparse infill. It helps save time by not having to do infill every layer.
This way you can have a fine outer perimeter, yet have a coarse infill.
With an increase in my infill extrusion width, ive noticed much more strength in my parts.
Re: Tip of the Day 7- Infill tab, a technical analysis
Posted: Tue Jan 20, 2015 5:23 pm
by jimc
x2 gotta agree with 10k. the infill width setting is great. jfettig is right though that in normal instances it
does not actually increase the width because there is a 1 layer gap below it so ithe extrusion wont
squish to the proper width. it just pumps out more material to make the infill solid and fill that 1 layer
gap. the strength is night and day. sparse infill works great for time savings as well. it doesnt however
work good for petg. abs it always worked great for.
Re: Tip of the Day 7- Infill tab, a technical analysis
Posted: Tue Jan 20, 2015 9:01 pm
by dsegel
You may want to add something about the density that is required for a good surface finish - I find that
you need at least 20% infill to get a smooth surface finish on top layers. Below that and the surface
threads can fall between the infill layers, leading to a bumpy or less-than-solid surface.
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Tip of the Day 8- Scripts tab, G-Code
Posted: Mon Jan 19, 2015 2:12 am
by KeyboardWarrior
Introduction:
The scripts tab is a really powerful tool in the FFF settings window. This allows you to set Starting
Scripts, set G-Code for every Tool Change, set G-Code for every Layer Change and set G-Code for the
end of your print!
If you're intimidated by G-Code, it's actually a lot easier than it looks, a great way of learning and
testing is to use the Communications tab over USB connection and send your printer a line of G-Code
at a time to see the responses. One thing to keep in mind is that different printers will accept different
commands to accomplish the same task. This is just something you should keep in mind if you’re
wondering why a certain G-Code command does not work with your printer.
Basics of G-Code:
G-Code is read line by line, the printer will accomplish one line of G-Code, then move on to the next.
Always capitalize the letters in G-Code, spacing is important, and anything that comes after a semicolon will not be read on that line. The two lines below are for home-all, and then move to 100, 100,
100 at a certain speed. The printer will home all 3 axis, then once that is done, move to the next line of
G-Code.
G28; home all axis
G1 X100 Y100 Z100 F3600; Move to X100, Y100, Z100 at 3600 mm/min
(G-Code is natively in mm/min)

The link below is extremely useful, a glossary of G-Code commands for RepRap style printers
http://reprap.org/wiki/G-code
Scripts Tab:
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Starting G-Code:
This is the G-Code that will be ran after heating up but before your print. Traditionally, this will consist
of homing the printer, potentially purging the nozzle, wiping the nozzle and running an auto-leveling
function if the printer supports it. In addition, you can add PID values, or set toolhead offsets here if
you'd like to.
If you're not a fan of the fact that Simplify3D heats up the bed/extruder, than runs your starting-script,
you can customize this, by using the commands below. If you have the commands for
[bed#_temperature] or [extruder#_temperature] in your starting G-Code script, the software won't add
in heating commands, it will just run off of the commands in your starting script.
[fan_speed_percentage]
[fan_speed_pwm] - for example, M106 S[fan_speed_pwm]
[extruder0_temperature] - for example, M104 S[extruder0_temperature] T0; this will take the layer 1
temperature for extruder 0
[extruder1_temperature]
...
[bed0_temperature] - for example, M140 S[bed0_temperature] T0; this will take the layer 1
temperature for bed 0
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[bed1_temperature]
...
Layer Change G-Code:
I personally haven't had to use this, but I'm sure that there are some excellent reasons/ideas to use for
this. If you'd like for a G-Code script to be inserted in-between each layer, than you can simply place it
in this tab. One interesting use of this, is for the FlashForge Dreamer, to have the lights blink in
between each layer, however that can be a bit too much at times! The placeholders that are available for
this tab are below:
[previous_Z_position]
[current_Z_position]
Tool Change G-Code:
This tab will insert G-Code on tool change commands. These commands can help do a ton of things for
multiple extruder prints, especially if using the IF command functionality. For instance, if you wanted
to change the temperature of your extruders (T0, and T1) for each tool change switch:
G28 X0 Y0; homes X-Y axis
{IF NEWTOOL=0}M104 S165 T1; set T1, inactive extruder to 165 C
{IF NEWTOOL=0}M109 S220 T0; Set T0, new active extruder to 220 and wait for it to reach
temperature before proceeding.
{IF NEWTOOL=1}M104 S220 T1; set T1, Heat T1 to 220
{IF NEWTOOL=1}M109 S165 T0; Cool T0 to 165
If you were using one process (printed part with one extruder, support with the other), you would only
need this script in your one process. However, if using multiple processes, you would need to
copy+paste this into each process.
{IF OLDTOOL=0}G1 E-10 F1800 - this will only include the line that precedes the {IF} brackets if
the old tool (the one that was active prior to the tool change) is tool 0. You could use scripts like this to
have different tool change retract distances for different tools
{IF NEWTOOL=0}G1 E10 F1800 - similar to the above command, however it checks the new tool
(the one that will be active after the tool change)
[old_tool]
[new_tool]
[current_Z_position]
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Ending G-Code:
Usually the Ending G-Code's purpose will be to get the nozzle off of the part and then turn off the
heaters/motors. The Ending G-Code below is taken from the RoBo 3D profile:
M104 S0 ; turn off extruder
M140 S0 ; turn off bed
G28 X0 ; home X axis
M84 ; disable motors
The placeholders available for the Ending G-Code:
[current_Z_position]
Post Processing:
Create X3G file for MakerBot printers using GPX plugin: This is enabled for all of the MakerBot(Not
5th Gen MakerBot)/Sailfish style printers. The conversion will take your Machine Profile from the
X3G tab of the Firmware Configuration and use that to convert your G-Code file to X3G. When you
click Save Toolpaths to disk after slicing, the X3G file is automatically created when you save a .Gcode
file.
Add Celebration to end of build: Add song to end of build, using Random always keeps things new
when printing
Create .MakerBot file for 5th generation printers: Converts the G-Code file into .MakerBot file. Similar
to the X3G, when you click Save Toolpaths to disk after slicing, the .MakerBot file is automatically
created when you save a .Gcode file.
Additional Terminal Commands for Post Processing:
If you are using a custom GPX ini file, this a very important section, as you will need to reference GPX
in this section rather than use the built-in functionality. There's also a ton of post-processing commands
below that help for those who are working with custom firmwares, or doing projects with their printers
that require more functionality.
Using the Post Processing box would be if using a MakerBot/Sailfish style printer that doesn't
have traditional steps-per-mm values, you would need to do the following:
1) Use the Machine ini example to set a text document ini with your machine information:
https://github.com/whpthomas/GPX/blob/master/examples/example-machine.ini
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2)Save the file as GPX.ini, place it in the Simplify3D installation folder
3)Place the following in the post-processing box: GPX [output_filepath]
Below are the post-processing tools that also work in the post-processing box:
{REPLACE "E" "A"} - search and replace for the text within quotes, in this example every "E"
character would be replaced with an "A" character
{PREPEND "G92 E0\n"} - prepends the specified text at the very beginning of the gcode file, note that
the \n is converted into a true newline character, not two separate "\" and "n" characters
{APPEND "G28 X0 Y0\n"} - appends the specified text to the very end of the gcode file
{DELETE "M82\n"} - deletes every occurrence of the specified text from the gcode file, note that it
will not automatically delete a line if it is suddenly empty after the deletion, so that is why you might
want to include the \n at the end (so that the empty line is also removed)
{STRIP ";"} - completely deletes every line in the gcode file that begins with the specified text
{TOOL0REPLACE "E" "A"} and {TOOL1REPLACE "E" "B"} - these special TOOL#REPLACE
commands will do a search and replace, very similar to the {REPLACE} command, however, the
replace only occurs if the specified tool is active. For example, when using TOOL1REPLACE, the
replacement will only occur if tool 1 was currently active at that line of the gcode file
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Tip of the Day 9- Support Gap inbetween Processes
Posted: Tue Jan 20, 2015 12:24 pm
by KeyboardWarrior
This is something will happen if you setup a part with two processes that has support. The default
settings for support material configuration will set it up, so that you will have a gap of 2 layers in the
middle of your support that is very-much unwanted.
The screenshot below is for a print of the Statue of Liberty, default supports and two processes.
Process 1- From 0 to 5 mm
Process 2- From 5 mm onwards
You can clearly see that there's missing support layers where the arrow points, where Process 1 ends,
and Process 2 starts.

To fix this, we need to change settings in the Support Tab for each process.
In the Support tab settings, there's the option for Upper Vertical Separation Layers and Lower Vertical
Separation Layers. In order to get rid of the Gap in the support in the picture above, you would need to
change these settings.
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Process 1- From 0 to 5 mm: Upper Vertical Separation Layers set to Zero
Process 2- From 5 mm onwards: Lower Vertical Separation Layers set to Zero
After those changes are made, the file will slice without any gap between the two processes.

If you're new to printing one part with different settings for different regions, the tutorial below is very
helpful in explaining the process.
http://www.simplify3d.com/support/tutorials/different-settings-for-different-regions-of-a-model/
Re: Tip of the Day 9- Support Gap inbetween Processes
Posted: Tue Jan 20, 2015 12:43 pm
by JFettig
Except any bottom support layers above 5mm will be stuck firmly to the part.
Re: Tip of the Day 9- Support Gap inbetween Processes
Posted: Tue Jan 20, 2015 12:55 pm
by KeyboardWarrior
JFettig wrote:Except any bottom support layers above 5mm will be stuck firmly to the part.
I haven't had that problem in the prints I've done. However, if that's something you are worried about,
keep the lower vertical separation at 1 for the upper layer.
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Tip of the Day 10- Extruder tab, a technical analysis
by KeyboardWarrior » Wed Jan 21, 2015 3:57 pm

Overview Section
Extruder Toolhead Index: This is the Identifier your associated with your extruder head that is decided
in your firmware. The general convention is your first tool will be T0, if you have multiple extruders
general convention also is that T0 will be the right extruder and T1 will be the left extruder.
Nozzle Diameter: This is the diameter of the tip of your nozzle where plastic is extruded from.
Traditional values range from .3 mm all the way up to 1 mm for some of the more customized printers.
A smaller nozzle is great for thin walls, for printing small miniatures and other things that require fine
precise details. Large 1 mm nozzles are great for rapid prototyping, creating large parts quickly and
efficiently by pushing out lots of plastic.
Extrusion Multiplier: The extrusion multiplier will multiply the amount of filament extruded for your
entire print. This includes skirts, rafts, supports, perimeter and infill extrudes. The default values in the
software are .90 for PLA and 1.0 for ABS. If you notice that your Top solid layers are not as filled-in as
you'd like them to be, I would recommend increasing the # of top solid layers, and if you still think
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there's an issue then this is the setting I'd recommend changing.
Extrusion Width: The slicing engine doesn't use your nozzle diameter, but instead uses your Extrusion
Width setting. For most cases, keeping this setting on Auto (1.2x your nozzle diameter) is the best
route, however for certain cases where you have extremely thin nozzles, you may find it's best to go to
Manual and play with lowering the Extrusion Width setting.
Ooze Control
Retraction Distance: How much filament will be retracted when the software does a retract. For
standard Direct Drive, usually .5 to 2.5 mm will work well. For Bowden extruders, 5 to 8.5 mm seems
to work well.
Extra Restart Distance: When the software does a prime (after retracting), it will prime the same
amount as retracted. However, you can modify this by placing an Extra Restart Distance, if you notice
that your prints have minor blobs at the starting points, you may find that placing a small negative
Extra Restart Distance can help, such as -.2 mm.
Retraction Vertical Lift: The nozzle will move up in the Z-axis whenever you do a retract. This is
particularly helpful with Delta printers and prints that have a lot of islands, since the delta printers can
be prone to running into parts when doing rapids.
Retraction Speed: The speed at which the filament will be retracted/primed. I think 1800 mm/min or 30
mm/sec is about as slow as I'd want to go for standard retracts, that going quicker will help for print
quality in most cases.
Coasting Distance: Setting a coasting value can be good if you want to empty out your nozzle before
doing a retract. Lets say you're printing a single line that is 100 mm long. If you set a coasting distance
of 5 mm, the extruder will be pushing out plastic for the first 95 mm of traveling, but then stop
extruding and while it will move over the rest of the line, it will not actually extrude anything for the
last 5 mm. It will instead depend on the filaments momentum, and gravity to let the rest of the filament
ooze out and fill in the region for the last 5 mm of the line.
Wipe Distance: Wiping happens after you've printed your outer most outline (Advanced tab, there's an
option that's usually enabled for this). When you print your outer most outline, when it's time to do a
retract, there's a good chance that not all of the filament in the extruder nozzle head is going to rise up,
that a blob of molten liquid plastic is going to be at the tip of the nozzle still. For this reason, instead of
rapidly moving to the next spot right away, you can use the Wipe function, which will wipe over the
perimeter and let that filament ooze out, similar to Coasting. However, Coasting is not extruding over
areas that need filament (you risk under-extrusion voids if coasting value is too high), Wiping is not
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extruding over areas that have already been printed on(much lower risk of part quality being negatively
effected).

There's a lot of terms in there, but here's the order they go in for an outer perimeter:
1) Finishing printing outer most perimeter
2) Coasting starts __ mm before outer most perimeter is done
3) Retract __ mm at ____ Retraction Speed
4) Wipe __ mm over the outer most perimeter
5) Vertical lift up __ mm
6) Rapid move at Rapid Move Speed (Other Tab)
7) Vertical lift down __ mm
8) Prime filament. Amount primed is Retraction Distance+ Extra Restart Distance
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Tip of the Day 11- Customizing Printer Profiles!
Posted: Fri Jan 23, 2015 3:16 pm
by KeyboardWarrior
A great thing about editing printer profiles, is the ability to go in and customize beyond what the
software allows for. For instance, in one of my profiles, I've set it up so that there is a preconfigured
button for NinjaFlex material and PET + filament as well.

To edit your printer profile and have customized settings for the auto-configures, click Edit Process
Settings, and then use the Export button to Export a .FFF printer profile. Then use a text-editor to open
this file (Notepad, Notepad++, TextEdit, etc). Once the .FFF file is open in a text editing program,
scroll to the bottom of the file, where the auto-configures are stored. They are stored in XML format,
and very easily configurable.
For instance, the default configurable settings for PLA and ABS:
<autoConfigureMaterial name="PLA">
<globalExtruderTemperature>190</globalExtruderTemperature>
<globalBedTemperature>60</globalBedTemperature>
<globalExtrusionMultiplier>0.9</globalExtrusionMultiplier>
<fanSpeed>
<setpoint layer="1" speed="0"/>
<setpoint layer="2" speed="100"/>
</fanSpeed>
</autoConfigureMaterial>
<autoConfigureMaterial name="ABS">
<globalExtruderTemperature>225</globalExtruderTemperature>
<globalBedTemperature>100</globalBedTemperature>
<globalExtrusionMultiplier>1.0</globalExtrusionMultiplier>
<fanSpeed>
<setpoint layer="1" speed="0"/>
</fanSpeed>
</autoConfigureMaterial>
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This really allows you to customize however you see fit.
For instance, if you wanted to place <defaultSpeed> for each configurable that's an option too. There's
tons of possibilities.
Re: Tip of the Day 11- Customizing Printer Profiles!
Posted: Sat Jan 24, 2015 4:49 pm
by AK_Eric
Great info, I thought I'd give it a shot. Immediately ran into a problem:
I'm unable to insert in, or modify any pre-existing autoConfigureMaterial elements.
For example, if I change this line:
<autoConfigureMaterial name=“PVA”>
to
<autoConfigureMaterial name=“test”>
or even just lowercase:
<autoConfigureMaterial name=“pva”>
S3d gives me a continual stream of
Failed to Parse XML File:
Expected ''' or '"' but got '[a-zA-Z]'.

Error windows.
If instead I decide to insert my own elements, I get the same error. I'm familiar with xml editing and
markup , so I'm pretty sure all my syntax is correct.
Any thoughts on what I'm doing wrong?
thanks!
Re: Tip of the Day 11- Customizing Printer Profiles!
Posted: Sun Jan 25, 2015 12:53 am
by dsegel
You may be inserting "smart quotes" instead of plain text. Make sure you're editing the file in a plain
text editor and not something like MS Word. Another possibility is the line ending you're using.
What OS (Mac, Windows, Linux) and what application are you using to edit the file?
Re: Tip of the Day 11- Customizing Printer Profiles!
Posted: Mon Jan 26, 2015 12:44 pm
Page 34 of 77

by AK_Eric
Interesting : Just using 'text edit' on mac. But I'll try mixing it up and see what happens
Re: Tip of the Day 11- Customizing Printer Profiles!
Posted: Mon Jan 26, 2015 4:31 pm
by TenKOhms
dsegel wrote:You may be inserting "smart quotes" instead of plain text. Make sure you're
editing the file in a plain text editor and not something like MS Word. Another possibility is
the line ending you're using.
What OS (Mac, Windows, Linux) and what application are you using to edit the file?

Yep this happened to me with text edit on Mac as well, even in plain text mode. Go to TextEdit >
Preferences and disable smart quotes.
Re: Tip of the Day 11- Customizing Printer Profiles!
Posted: Tue Jan 27, 2015 1:04 am
by bryan
I'd recommend TextWrangler, the free version of BBEdit.
Re: Tip of the Day 11- Customizing Printer Profiles!
Posted: Fri Jan 30, 2015 5:33 am
by ghiom
That's one of the most usefull tips about S3D !!
I'm trying to create a colorfabb profil for each of my printer with "PLA" " WOOD" "Bronze" "XT"
Things wich are differents are not only extruder temp annd bed temp , but retraction speed, retraction
distance ...
so, i create this code :
<autoConfigureMaterial name="PLA">
<globalExtruderTemperature>190</globalExtruderTemperature>
<globalBedTemperature>50</globalBedTemperature>
<globalExtrusionMultiplier>0.9</globalExtrusionMultiplier>
<fanSpeed>
<setpoint layer="1" speed="0"/>
<setpoint layer="2" speed="100"/>
</fanSpeed>
</autoConfigureMaterial>
<autoConfigureMaterial name="WOOD">
<globalExtruderTemperature>190</globalExtruderTemperature>
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<globalBedTemperature>50</globalBedTemperature>
<globalExtrusionMultiplier>1.0</globalExtrusionMultiplier>
<globalretractionSpeed>1500</globalretractionSpeed>
<globalretractionDistance>1.3</globalretractionDistance>
<globalminSpeedLayerTime>8</globalminSpeedLayerTime>
<globaldefaultSpeed>3000</globaldefaultSpeed>
<fanSpeed>
<setpoint layer="1" speed="0"/>
<setpoint layer="2" speed="100"/>
</fanSpeed>
</autoConfigureMaterial>
<autoConfigureMaterial name="BRONZE">
<globalExtruderTemperature>190</globalExtruderTemperature>
<globalBedTemperature>50</globalBedTemperature>
<globalExtrusionMultiplier>0.9</globalExtrusionMultiplier>
<fanSpeed>
<setpoint layer="1" speed="0"/>
<setpoint layer="2" speed="100"/>
</fanSpeed>
<primaryExtruder>1</primaryExtruder>
<retractionSpeed>2000</retractionSpeed>
<retractionDistance>4.5</retractionDistance>
<minSpeedLayerTime>8</minSpeedLayerTime>
<defaultSpeed>3000</defaultSpeed>
</autoConfigureMaterial>
<autoConfigureMaterial name="XT">
<globalExtruderTemperature>240</globalExtruderTemperature>
<globalBedTemperature>70</globalBedTemperature>
<globalExtrusionMultiplier>1.0</globalExtrusionMultiplier>
<fanSpeed>
<setpoint layer="1" speed="0"/>
<setpoint layer="2" speed="100"/>
</fanSpeed>
<primaryExtruder>1</primaryExtruder>
<retractionSpeed>2400</retractionSpeed>
<retractionDistance>4.5</retractionDistance>
<defaultSpeed>3000</defaultSpeed>
</autoConfigureMaterial>

Great ! now i read the materials names and chose the one i want .
but it's not modifying the retraction and other settings in the S3D Tab. Whats wrong ?
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Tip of the Day 12- Vase Mode
by KeyboardWarrior » Sun Jan 25, 2015 2:56 pm
Vase mode is an incredible feature for making really nice 3D prints. I'm a big fan of printing out vases,
since they look really good, are functional, don't use a lot of material and are great for giving away to
people who don't have 3D printers.

http://www.thingiverse.com/thing:18672/#files
To enable vase mode, click "Edit Process Settings", then go to the Layer tab and enable the option for
Single outline corkscrew printing mode.

Single outline corkscrew printing mode (vase mode): The extruder will print with one outline/perimeter
shell and won't make any retracts. This means that it will slowly move up in the Z as it prints, imagine
spiraling upwards, instead of printing a static layer, than moving upwards to do another layer. This
means there shouldn't be any seams in your print or any spots where retractions occurred, meaning that
the prints come out extremely smooth.
With vases the best settings I've found are Zero top solid layers, 3 Bottom Solid Layers, and under the
Advanced tab enable "Merge all outlines into a single solid model".
Also, under the extruder tab, you change your extrusion width slightly if you want to adjust the
thickness of the walls of the vase. For instance, if you have a .4 mm nozzle, but want a thicker vase,
you could change the Extrusion Width to .50 mm.

Overall though, Vase model is for much more than just vases. Really any part that has a single "island"
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that can be printed without support and 0% infill is a good candidate for vase mode, since it will
produce extremely clean perimeter outlines with no retractions. For instance, if printing a model of a
pyramid, you could definitely use Vase-mode and get a really nice finish!
Also, to expand on the setting for "Merge all outlines into a single solid model" - This feature in the
software will slice the model taking all of the outer most perimeter outlines. For instance, if you had a
model that was a block with screw-holes in it, but had "Merge all outlines into a single solid model" on,
the holes would not show up. Using Merge all outlines is generally really useful for models that have
errors in the mesh or if using Vase Mode.
Lastly, vase mode will work for parts that do have multiple island - a great example is this part
(http://www.thingiverse.com/thing:323038). It transitions from multiple island (2) at the lower half
with the tail and body, but then to a single island at the top. You might look at it and say because there
will need to be retractions between these islands that vase mode wouldn't work, because the tail would
be an island and the body would be an island. But the software will actually intelligently switch back
and forth between normal printing mode and vase mode if you try to slice that model using vase mode
settings. This means that even if a model has areas with multiple islands, that aren't compatible with
vase mode, you can still use that settings, and the software will automatically choose the best method
as it goes.
The part only has retractions where multiple islands are, where retractions are needed!
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Re: Tip of the Day 12- Vase Mode
by TenKOhms » Sun Jan 25, 2015 7:17 pm
I feel like this would be cool to watch on a 3d printer using polar coordinates
Re: Tip of the Day 12- Vase Mode
by dsegel » Sun Jan 25, 2015 9:14 pm
How large an extrusion width can one reasonably set things to if I have a 0.4mm nozzle? The default
(0.48mm) leads to too-thin walls on my prints, making them very fragile.
dsegel
Re: Tip of the Day 12- Vase Mode
by jimc » Sun Jan 25, 2015 10:05 pm
i think that will vary a bit on the design of your nozzle. some are sharper than others. my e3d for
instance has a larger flat area so i can get wider. if the nozzle comes to a sharp point then you cant get
too wide with it. my nozzle i have easily done .65 width with a .4 nozzle. i frequently print at .55. this
is almost my normal print width on most things.
Re: Tip of the Day 12- Vase Mode
by KeyboardWarrior » Sun Jan 25, 2015 10:24 pm
dsegel wrote:How large an extrusion width can one reasonably set things to if I have a
0.4mm nozzle? The default (0.48mm) leads to too-thin walls on my prints, making them
very fragile.

I agree with JIMC about extruder design, but also a big thing is temperature and material. The higher
the temperature, the lower the viscosity will be meaning the material will have a much better flow.
Also: Edited the main post to add more information about Vase mode.
Top

Re: Tip of the Day 12- Vase Mode
by ejeklint » Sun Feb 01, 2015 1:03 pm
Great tip! One thing though: what's with the print speed when printing in vase mode? It's horribly slow,
like 10 mm/s. Is that what I should expect or have I missed some setting?
ejeklint
Re: Tip of the Day 12- Vase Mode
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by JoeJ » Mon Feb 02, 2015 6:09 am
It's probably going slow for cooling. You need to make sure the plastic has time to cool before the next
extrusion is placed on top of it. But you can always disable of modify these settings by click Edit
Process Settings and then choosing the Cooling tab. You can disable it completely by unchecking the
option called "Adjust printing speed for layers below XXX seconds" (although I wouldn't suggest it!)
JoeJ
Re: Tip of the Day 12- Vase Mode
by ejeklint » Mon Feb 02, 2015 9:54 am
JoeJ wrote:It's probably going slow for cooling. You need to make sure the plastic has time
to cool before the next extrusion is placed on top of it. But you can always disable of
modify these settings by click Edit Process Settings and then choosing the Cooling tab. You
can disable it completely by unchecking the option called "Adjust printing speed for layers
below XXX seconds" (although I wouldn't suggest it!)

Yes, you're right. Found out this morning and now print speed is much nicer.
ejeklint
Re: Tip of the Day 12- Vase Mode
by ejeklint » Mon Feb 02, 2015 10:28 am
Another question about vase mode - what settings should I change when vase comes out leaky? My
bottom layers doesn't fill completely apparently. It's when the infill layer meets the perimeter at certain
angles that very tiny holes appear. I've tried increase extrusion and add another layer but that doesn't
help 100%.
ejeklint
Re: Tip of the Day 12- Vase Mode
by KeyboardWarrior » Mon Feb 02, 2015 10:31 am
ejeklint wrote:Another question about vase mode - what settings should I change when vase
comes out leaky? My bottom layers doesn't fill completely apparently. It's when the infill
layer meets the perimeter at certain angles that very tiny holes appear. I've tried increase
extrusion and add another layer but that doesn't help 100%.

Increasing the number of bottom solid layers can help a lot, as well as slightly increasing the extrusion
multiplier by 3 or 4% as well should help.
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Tip of the Day 13 - Repair Features in Simpify3D
Posted: Mon Jan 26, 2015 3:22 pm
by KeyboardWarrior
Simplify3D has some really nice repair features for repairing and fixing parts. The two in particular I'd
like to focus on our Flip Surface Orientation and Merge outlines into solid single model. From there,
the Repair tutorial on the website it does a good job expanding on the rest of the features.
Flip Surface Orientation
The most common repair feature I use in day-to-day printing I would say I use is to Flip a surface
feature. To access this feature, go to Repair-> Flip Surface Orientation-> then click on the surface of
the model you'd like to flip. The part looks different, so right away you know there's an issue.

After using the repair feature.
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Screen Shot 2015-01-26 at 2.08.43 PM.png (61.17 KiB) Viewed 180 times

For flipped surface orientations, sometimes it will be obvious because you can't apply support to a
certain section of a part, or the model is slicing incorrectly as well. All-in-all this is a very easy fix and
many models I've downloaded off of Thingiverse have required this simple one-click fix.
Merge all outlines into a single solid model (Advanced Tab FFF Settings) - I've talked about this
feature for the Vase mode tip of the day, but for other parts it can be useful as well. This feature in the
software will slice the model taking all of the outer most perimeter outlines. For instance, if you had a
model that was a block with screw-holes in it, but had "Merge all outlines into a single solid model" on,
the holes would not show up.
In addition, Merge all outlines into a single solid model is good for thin-wall printing if you'd like to
ensure that one perimeter outline is printed. That way you're only printing the outer perimeter, not the
outer and inner.
For the rest of the repair features, I would advise for looking at the tutorial on the tutorials page for
Repair features.
Also, one last thing is to use the Identify Non-Manifold Edges option, which will highlight in red
problematic areas that show where the mesh is either not "water-tight" or has extra/unwanted surface
faces that are causing conflict.
Repair Normals – This will recalculate the normal vectors for your model to help prevent
issues where the normal is facing the incorrect direction
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Repair Flipped Triangles – The software will analyze your model and look for any surfaces
where a triangle appears to be facing the wrong direction. Typically all connected triangles
are facing the same direction and this option will help correct those issues.
Flip Surface Orientation – Using the Repair Flipped Triangles tool is great, but you may
run across a scenario where all of your triangles are pointing the same direction, but it is the
wrong direction! In this case, you can use the flip surface orientation option. You just click
the surface you want to flip and all of the triangles attached to that surface will be reversed.
Remove duplicate triangles – This will look through your model and remove any duplicate
overlapping triangles
Remove orphaned triangles – Any triangles that are unattached to the rest of the model will
be deleted
Note that these tools will only alter the mesh as it exists within the software. It won’t make
any changes to your original STL file. If you want to save your work you can go to File >
Export STL to create a new repaired STL file.

Source: http://www.simplify3d.com/support/tutorials/identifying-and-repairing-common-mesh-errors/
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Tip of the Day 14 - Setting up your printer with Simplify3D
by KeyboardWarrior » Tue Jan 27, 2015 4:48 pm
When using the Configuration Assistant, there's a ton of profiles to pick from, but if you have a printer
that's not on this list, you'll have to make your own profile. This is a very quick process, but if you've
never done it before it can be a bit confusing. If your printer is not on the list, you select the option for
Other, then fill out your machines information.

Machine Type: This is pretty standard, if you have a delta printer or circular build plate it will be a delta
style build platform. For delta users, you will take your diameter, multiply it by .707 and that will be
the X-axis and Y-axis size to input for Build Volume.
Firmware: RepRap(Marlin/Repetier/Sprinter) most printer choices will be for this. Especially since
almost every MakerBot/Sailfish style printer I can think of has a build in profile already on the
Configuration Assistant you can pick from.
Baud Rate: This is the rate at which USB transmission occurs, your manufacturer can provide this
information if you don't have it. **Generally 115200 or 250000** will be the baud rates.
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The Build Volume, Nozzle Diameter, filament diameter, number of extruders and check mark for a
heated bed are all pretty self explanatory.
Calibrating:
There are a few things you'll want to calibrate for your profile. The default profiles work really well, I
think there made to accommodate the Prusa i3's and bulk of the RepRap models. However, there are a
few things that you should probably check to ensure great prints.
To access and make these changes, click "Edit Process Settings"
1.Temperature (Temperature Tab)
For PLA the default profiles are 190 C for the extruder and 60 C for the bed. If you were printing with
Slic3r or Cura and printing at 215 C for PLA, it's definitely going to have a drastic difference on
extrusion if you are now all of a sudden printing with a 25 C difference.
Likewise, for ABS, the default temperatures are 225 for the extruder and 100 for the bed. If your heated
bed maxes out at 65C, then definitely be sure to change the setting to accommodate your machine.

2.Retraction (Extruder Tab)

For standard Direct Drive, usually .5 to 2.5 mm will work well. For Bowden style extruders, 5 to 8.5
mm seems to work well. Changing the retraction speed may also help quality, the default 1800 mm/min
is usually pretty good though.
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3.Extrusion Multiplier (Extruder Tab)
The default extrusion multiplier is .9 for PLA and 1.0 for ABS. If you notice that there's incomplete
filling or if there's too much filament I highly advise tinkering with the extrusion multiplier. My general
tinkering, I usually adjust the value by .03 at a time for test prints.

Adjusting these three settings can really help setup your printer profile in Simplify3D and produce
great prints
Re: Tip of the Day 14 - Setting up your printer with Simplif
by CT4 » Wed Jan 28, 2015 3:44 am
I am very confused with the extrusion multiplier. If I am under extruding filament do I raise the % or
lower it? The way I see it is if I have 1.75mm filament and apply the extrusion multiplier value of
0.90% then I am telling the slicer that the filament is 1.575mm so it would use more filament ??? I
would appreciate an explanation as to how this works.
Re: Tip of the Day 14 - Setting up your printer with Simplif
by KeyboardWarrior » Wed Jan 28, 2015 9:18 am
Changing the filament diameter will change the amount extruded as well. My advice is to keep the
filament diameter where it's supposed to be, and then slightly change the extrusion multiplier as
needed. A higher extrusion multiplier=more extrusion out of your nozzle.

For the filament diameter, changing that has a big difference and it doesn't scale on a standard ratio as
extrusion multiplier does, since changing the filament diameter changes the Area of the filament which
is proportional to diameter squared.

Sometimes measuring your filament with calipers and using that as your filament diameter instead of
taking the sticker amount is a good idea though.
Re: Tip of the Day 14 - Setting up your printer with Simplif
by TMI » Wed Feb 04, 2015 5:01 am
"For delta users, you will take your diameter, multiply it by .707 and that will be the X-axis and Y-axis
size to input for Build Volume."
Please tell me is that the diameter of the platform? I have a buildplatform with a diameter of 30 cm.
Would that imply that I have a build volume of 21.21 cm?
Re: Tip of the Day 14 - Setting up your printer with Simplif
by TenKOhms » Wed Feb 04, 2015 7:40 am
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TMI wrote:"For delta users, you will take your diameter, multiply it by .707 and that will be
the X-axis and Y-axis size to input for Build Volume."
Please tell me is that the diameter of the platform? I have a buildplatform with a diameter
of 30 cm. Would that imply that I have a build volume of 21.21 cm?

I'm not sure if .707 is the number to use or not, but at least on my delta, I can't access the full range of
my bed. For example, if i move the head manually by hand, there's no way I can get it to reach the full
range near the towers
Re: Tip of the Day 14 - Setting up your printer with Simplif
by KeyboardWarrior » Mon Feb 09, 2015 11:56 pm
TMI wrote:"For delta users, you will take your diameter, multiply it by .707 and that will be
the X-axis and Y-axis size to input for Build Volume."
Please tell me is that the diameter of the platform? I have a buildplatform with a diameter
of 30 cm. Would that imply that I have a build volume of 21.21 cm?
You still get to use the full size of your platform, it will still create the G-Code for your full
size and you can max out your printers size, just for placing in the build volume of your
printer in the software you do it for the X and Y of the largest square that will fit inside
your circular build volume.
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Tip of the Day 15 -Setting up your Auto-Bed Leveling
Posted: Fri Jan 30, 2015 4:45 pm
by KeyboardWarrior
Intro
In the software, you may of noticed that the Robo 3D profile has two profiles, one for Robo 3D's with
auto-levelers and one for Robo 3D's that don't have autoleveling capabilities.
To have auto-leveling, you need extra end-stops that can detect when your nozzle touches the bed of
your printer and these settings need to be configured in your firmware. There are many Solidoodle
printers, Robo printers, RepRap designs, all of whom support this Marlin feature.

Nuts n Bolts- How it works
The extruder will move to 9 different points on the bed, and probe each of them. It knows the X-Y
location of where it's probing, and it can measure how far off the Z-plane is. Here you can see that the
Z-plane measurements range from -.45 to -1.75 mm, a full 1.3 mm off (or 6 layers of standard
printing). After probing these 9 spots, it will know the beds plane (since the bed is not flat) and will
compensate when printing by moving in the Z-axis as printing.
For standard prints, the Z-axis will move only when changing layers, however if the bed-leveling
feature is enabled, then the Z axis will constantly be moving to adjust and compensate.
For more information, a great read from the Robo 3D forums:
http://forums.robo3dprinter.com/index.php?threads/robo3d-autolevel-via-mike-kelly.2574/

How to use it:
The command that runs the Auto-leveling is G29 *Marlin Firmware's with bed leveling enabled*.
However, you may also find that M565 Z-1 helps set an offset for the auto-leveler. This command is
optional, many people find they get better performance with it, however there's also many Robo owners
who use M565 Z0 (which effectively means it's not there) and get great first layers as well.
G28 ; home all axes
G1 Z5 F5000 ; lift Z by 5mm
M565 Z-1 ; set the offset for auto-leveling mechanism
G29 ; run auto-level

Conclusion:
G29 is an amazing command and uses the mathematics of probing the 9 points to make 3D printing
easier. However, if you can manually adjust your print bed, to help create a level plane that is also
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great, since you don't want to be overly dependent on the G29 command.
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Tip of the Day 16 - Wanhao 5S/5S mini with Simplify3D slicer
Posted: Mon Feb 02, 2015 10:08 am
by KeyboardWarrior

The Wanhao 5S is an extremely sturdy machine, and has a great design. However, the firmware on the
machines only allow it to run .i files. .i files are a bit different than .Gcode files. You can either flash
the firmware on your Wanhao 5S with experimental firmware from user Jetguy, or use Fusiontek
Ideamaker software to translate G-Code files.
Step 1) Making a G-Code file from Simplify3D
Download the FFF file for your printer (slicing settings file)
Simplify3D profile for Wanhao S5- Large
JetguyD5 Repetier.fff
(6.09 KiB) Downloaded 5 times
Simplify3D profile for Wanhao S5-Mini
JetguyD5-MiniRepetier.fff
(6.81 KiB) Downloaded 5 times
After downloading that file, in Simplify3D click "Edit Process Settings" and import the FFF file.
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Once this has been done, you can drag in a 3D model model, select Prepare to Print and then click the
"Save Toolpaths to Disk" button, to save a .Gcode file.
Step 2) Sending the G-Code file to the Wanhao printer
You can either use FusionTech Ideamaker software to send convert the .Gcode to a .I file, or flash the
firmware on your Wanhao printer with Repetier firmware by Jetguy so it will read standard G-code.
FusionTech IdeaMaker Software-option to translate G-Code to .i files (Wanhao maker does not
have this feature)
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To download FusionTech Ideamaker Software that translates G-Code to .i files (Windows only)
http://www.filedropper.com/installideamaker1352241exe
To flash the firmware on your printer so it will read .Gcode files instead of .i files, use Jetguy's
Firmware for the D5 Wanhao (Repetier based), 115200 Baud Rate. Download Arduino software
to flash this onto your printer.
RepetierD5Jetguy.zip
Jetguy's Firmware for the D5 Wanhao (Repetier based), 115200 Baud Rate. Download Arduino
software to flash this onto your printer.
(339.57 KiB) Downloaded 4 times

More information from Jetguy about the firmware
https://groups.google.com/forum/#!msg/wanhao-printer-3d/fzZSYHQN4_0/_tUDz41PgygJ
Re: Tip of the Day 16 - Wanhao 5S/5S mini with Simplify3D sl
Posted: Tue Feb 03, 2015 10:54 am
by KeyboardWarrior
Also, for anyone who needs FusionTech IdeaMaker software w/ Translate file see the link below:
http://www.filedropper.com/installideamaker1352241exe
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Tip of the Day 17 -New Feature- Horizontal Size Compensation
by KeyboardWarrior » Wed Feb 04, 2015 10:23 am

The horizontal size compensation is a new feature in version 2.2.2, if you don't see this option under
the Other tab, this may mean you are using version 2.2.1 or earlier. There are many, many usage case
scenarios for which you could use this feature. Taken from the blog post, the gear bearings by Emmet.
If you print these out, and the plastic has molded together, you could place a value of -.05 to increase
the gap by 1. mm, or -.1 mm gap to increase the gap by .2 mm (half the average nozzle diameter for
perspective). the gap is doubled, since both perimeters are compensating away from one another, so the
gap is twice the value of the input.
http://www.thingiverse.com/thing:53451
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That's one use case scenario, but there's also the use case for a standard print. For instance, if you print
a 25 mm cube and notice that it's 24.8 mm in the X-Y axis, then you print a 50 mm cube and it's 49.8
mm, you could add .1 mm to the size compensation to quickly remedy the size of your prints.
Re: Tip of the Day 17 -New Feature- Horizontal Size Compensa
by BaronWilliams » Wed Feb 04, 2015 3:34 pm
This is a great new feature of version 2.2.2. It's very helpful when printing functional parts that interact
with each other.
I wonder why slicers do not normally have this on the Z axis as well?
BaronWilliams

Re: Tip of the Day 17 -New Feature- Horizontal Size Compensa
by kenwshmt » Mon Feb 09, 2015 11:37 am
This may help mold making too, since the outside edge is slightly larger than it should be for a negative
mold.
http://www.thingiverse.com/thing:31581
any thoughts?
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Tip of the Day 18 - Advanced Tab, a technical analysis
by KeyboardWarrior » Wed Feb 11, 2015 2:55 am

Layer Modifications Section
Start Printing at Height: All models in this process will start printing at ___ Height (mm)
Stop Printing at Height: All models in this process will stop printing at ___ Height (mm)
These two options are used primarily if you want to print with different settings in one part. For
instance, if printing the Statue of Liberty below, you may want to print the base of the statue at a much
thicker layer height then the statue itself.
Two Process Statue of Liberty Example:
The first process would stop at 50 mm (assuming 50 mm is where the base ends) and the second
process would have a starting point of 50 mm so that the second process print settings would be applied
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to everything after 50 mm.
http://www.simplify3d.com/support/tutorials/different-settings-for-different-regions-of-a-model/Tutorial on printing different settings for different regions

Slicing Behavior
Non-manifold segments: Non-Manifold segments are errors in the mesh. These are relatively common,
the best behavior traditionally is to use Heal to attempt to patch up these missing areas. I personally
have not needed to use the Discard option.
Merge all outlines into a single solid model:This feature in the software will slice the model taking all
of the outer most perimeter outlines and slice with those assuming a solid model as the interior. For
instance, if you had a model that was a block with screw-holes in it, but had "Merge all outlines into a
single solid model" on, the holes would not show up. Using Merge all outlines is generally really useful
for models that have errors in the mesh or if using Vase Mode.
Thin Wall Behavior
Only use perimeters for thin walls: If printing a very thin wall, this means that the software will not add
in Infill into a very small crevices. If there's room to fit multiple perimeters, it will print in multiple
perimeters, but otherwise you'd be left with a small gap.
Allow gap fill when necessary: This setting will work to add in another perimeter by allowing as long
as it's within the overlap setting. Otherwise, it will fill the area with Infill.
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Ooze Control Behavior:
Only retract when crossing open spaces: This is enabled by default for most profiles, since you really
only need to do a retraction if you are crossing over an open space, since you would be crossing
perimeters and be at risk for stringing.
Force retraction between layers: Forces a retraction from layer to layer. This is recommended.
Minimum travel for retraction: If a movement is below this threshold, it won't retract for that
movement. This would be if your printer has a lot of problems with retractions, you may need to tweak
this, to limit the number of retractions your print has.
Extruder ooze rate: The features tool-tip states this is an experimental option, so I personally have not
experimented much with it. However, the idea would be to heat up your extruder, prime it, then wipe
the filament away and measure how many mm's of filament will slowly extrude out of the nozzle over
a minute, then using that data you would set that in your Extruder ooze rate setting.
Only wipe extruder for outer-most perimeters: This will ensure that you only use the Wipe feature
(Extruder tab) when needed, when it would effect the appearance of your model. Therefore, to save
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time and be efficient it will only wipe the extruder for outer-most perimeters. It may not be helpful to
wipe the extruder after doing Infill, however if you wanted the extruder to wipe after Infill you could
do that by unchecking this box.
Tool Change Retraction:
Tool change retraction distance: When changing tools, a retract of __ mm will occur. The idea is that
instead of a standard small retract, you can retract the filament far up the extruder to prevent any
oozing while the other tool is printing.
Tool change extra restart distance: When priming the extruder that was previously retracted, this extra
restart distance will be added to that value. For instance, if you have a tool change retraction of 12 mm,
and an extra restart of -.5 mm, the following will occur:
Print with Right extruder
Tool Change Retract Right Extruder (12 mm)
Prime Left Extruder (12 mm + (-.5 mm))= 11.5 mm prime
Print with Left Extruder
Tool change retraction speed: The speed at which the retraction and primes will occur for the tool
change retract/primes. I've found since you are moving much more filament, moving slower is very
important. Trying to retract 12 mm of filament at F4800 may cause a lot of skipping which leads to
other issues.
Re: Tip of the Day 18 - Advanced Tab, a technical analysis
by horst.w » Thu Feb 12, 2015 4:07 pm
Hi,
I can not change the value of Extruder Ooze Rate (default 100 mm/s).
After checking OK-Button and reopen Advanced the new value ist allways re-changed to 100.
Best regards
Horst, GER
... Tools>General Options> Preferences >>> Save ... is checked!
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Tip of the Day 19 - Additions Tab, a technical analysis
by KeyboardWarrior » Thu Feb 12, 2015 5:03 pm
Skirt Settings
Skirts are really useful for priming your extruder prior to printing. I generally print with a skirt offset of
4 mm and 2 outlines. However, changing the offset to 0 mm, offers the ability to create a "brim" that
will connect to your part and help create surface adhesion. For more information on skirts, brims, rafts,
this tutorial is very helpful:
http://www.simplify3d.com/support/tutorials/rafts-skirts-and-brims/
Skirt Extruder: Selects the extruder to be used for printing your Skirt
Skirt Layers: How tall your skirt will be. If you want the skirt to be as tall as your part, you can just
place 99999 in this field.
Skirt Offset:How far away your skirt will be from your part.
Skirt Outlines: # of perimeter outlines for your skirt.
Raft Settings
A raft offers a base understructure that will contour to the outline of your print, increasing the surface
area to the bed. This in-turn will offer more adhesion to the print bed. However, because rafts take a
long time to print and use a lot of material, it is only recommended to use rafts for prints that have a
low surface area with the print bed or that generally don’t have a good base will often benefit from a
raft. Also, whether due to the design of the printer or calibration, those users with beds that are slightly
uneven have often found that rafts can provide a good foundation.
Raft Extruder: Selects the extruder to be used for printing your Raft
Raft Layers: How many layers your raft will be.
Raft Offset:How far away your part the raft will extend out to.
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Separation: How much distance on the Z-axis from the raft to to the bottom of your part.
Raft Infill %: This will typically be set around 80%, set the top layer of your rafts infill.
Disable Base Layers: Disables the thicker layers at the start of the raft, disabling this can be helpful if
your rafts stick to the bed too much.
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Tip of the Day 20- G-Code Previewer
Posted: Tue Feb 17, 2015 1:31 pm
by KeyboardWarrior
The G-Code previewer is a tool that is extremely important. It shows exactly what the sliced G-Code
will instruct your printer to do. This can be really helpful for troubleshooting. For instance, if your print
has something that isn't in the G-Code previewer, that would mean something in the transmission of the
file, firmware or electronics/mechanics of your printer is causing the differences from the G-Code
previewer.

The green dots going down the part at the points at which a retraction will take place. The G-Code
previewer shows all the points where retractions will take place as dots/blobs. This can be confusing
for new users, who think that these areas that show the location of retractions are actual blobs of
plastic, whereas they're not.
**If this part was printed in Vase mode, there wouldn't be any retractions, it would be one smooth
extrude**
http://www.forum.simplify3d.com/viewtopic.php?f=8&t=1999
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The red lines going back and forth show the travel moves. These are the moves in which the print head
is not extruding, this can be helpful too. If you find a lot of stringing is occurring during these travel
moves, you can look into increasing your retraction distance and working with those settings, or
modifying your settings so there's not as many travel movements.
The G-Code previewer is extremely important as well for quick testing. For instance, if you're unsure
what the raft-offset option does, you could change it from the default 3 mm to 15 mm, and slice to see
what the G-Code looks like with the drastic change. Then go back and change the setting back to 3, I
did this very often when first starting to use the software to learn about all the settings, since
Simplify3D slices very fast, it's a quick way to check and see what changes.
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Tip of the Day 21 - Support tab, a technical analysis
Posted: Wed Feb 18, 2015 4:52 pm
by KeyboardWarrior
One of the best features in Simplify3D is the support material. The option of where to put it, in addition
to how easily it breaks off makes it a key feature.
https://www.simplify3d.com/support/tutorials/adding-and-modifying-support-structures/
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Support Material Generation
Support Extruder: Which extruder your support material will be printed with.
Support Infill Percentage: The Infill % your support will be printed with. For PLA/ABS anywhere from
20 to 40% usually works really well, I've typically left this on the default value.
Extra Inflation Distance: This will increase the amount of support generated in the X-Y plane.

Dense Support Layers: How many of the layers closest to your part will be filled with the dense infill
percentage
Dense Infill Percentage: The infill percentage for the top layers closest to your part. If you use
PVA/HIPS filament, this feature is definitely a must-have, so you can print the bulk of your support at
20-30% support, then bump it up to 60-100% for the layers that will have contact with your part.
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Print Support Every __ Layers: Similar to spare infill, sparse support means that it will extrude for your
support, but only print the support every ___ layers. For instance, if you have .2 mm layer height, and
print supported every 2 layers, it will print your support at a .4 mm layer height.

Separation from Part
Horizontal Offset From Part: How far away on the X-Y plane the support will be generated from your
part.
Upper Vertical Separation Layers: How far off in the Z-plane the support will be set from your part.
Generally you can keep this set to 1, unless you're using HIPS/PVA, you may want to set it to zero.
Lower Vertical Separation Layers:
http://www.forum.simplify3d.com/viewtopic.php?f=8&t=1973

Automatic Placement
Support Pillar Resolution: The size of the pillars generated. This is default at 4 mm, for smaller parts
you'll most likely need to lower this to one or two mm to get the support pillars you want.
Max Overhang Angle: The max overhang angle that will be allowed. I recommend this calibration test
piece for figuring out how well your printer works with support generally:
http://www.thingiverse.com/thing:40382
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Support Infill Angles
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…

Tip of the Day 23 - Other tab, a technical analysis
http://www.forum.simplify3d.com/viewtopic.php?f=8&t=2363
Page 1 of 1
Posted: Thu Mar 26, 2015 1:18 pm
by KeyboardWarrior

Default Printing Speed: This is the speed at which the Infill of your part will be printed, assuming the
Cooling Overrides don't adjust it and that it's not a 100% infill layer.
Outline Underspeed: For your perimeters, you print at a % of your Default Printing Speed, this is the
%. For instance, if you want to print your Perimeters at 75% of your Default Print Speed.
Solid Infill Underspeed: For your any layer that is 100% infill, including Bottom Solid Layers, Top
Solid Layers and if you have 100% infill set in your part, you print at a % of your Default Printing
Speed.
Support Structure Underspeed: The support material will be printed at a percentage of your default
printing speed.
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X/Y Axis Movement Speed: This is the speed your printer will move when your printer is not printing
in the X-Y axis. When looking at the G-Code previewer, you can see these lines as the Travel Moves

Z Axis Movement Speed: The speed at which your Z-axis will move.
Filament Diameter: The diameter of filament your printer uses. This is very important for extrusion
values. For instance, if you use 3 mm filament but have 1.75 mm filament in your setting, the software
will be turning your extruder motor FAR too much since it will think you are using only 1.75 mm
diameter filament. Small tweaks to this would be the same as small tweaks to your extrusion multiplier.
Filament Price: Price that you paid for your filament per kg, so that when you slice your file in the GCode preview you can see the estimated cost.
Unsupported area threshold: Any area larger than this that is unsupported will have the bridging
multipliers applied to the infill in the bridging.
Bridging extrusion multiplier: If you find that extruding a lot more/less material helps with bridging,
then you would set that here.
Bridging Speed multiplier:If you find that printing faster/slower helps with bridging, then you would
set that here. One trick I use occasionally, is I'll temporarily set the bridging speed multiplier to 999,
then slice my file, that way the areas in which the bridging multiplier is taking place are bright red and
stand out in the G-Code previewer, that way I have a better idea of where the bridging settings are
occurring.
Horizontal Size Compensation:http://www.forum.simplify3d.com/viewtopic.php?f=8&t=2042
Re: Tip of the Day 23 - Other tab, a technical analysis
Posted: Thu Mar 26, 2015 2:17 pm
by DarthRevan
One trick I use occasionally is I'll temporarily set the bridging speed multiplier to 999, then slice my
file, that way the areas in which the bridging multiplier is taking place are bright red and stand out in
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the G-Code previewer, that way I have a better idea of where the bridging settings are occurring.
This my friend is just plain GENIUS!
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Tip of the Day 24 - Cooling tab, a technical analysis
http://www.forum.simplify3d.com/viewtopic.php?f=8&t=2364
Page 1 of 1
Posted: Thu Mar 26, 2015 1:41 pm
by KeyboardWarrior

Per-Layer Fan Controls: You can edit the fan speed on a per layer basis. This is very similar to how the
temperature tab works*. The fan speed will only change when there's a command to have it change.
Therefore, if you set it to 60% at layer 1, the entire print will run at 60%. The most common
recommends for PLA/ABS are as follows:
PLA:
Layer 1- Fan off
Layer 2- Fan On 100%
ABS:
Layer 1- Fan off
*When printing with multiple processes, the layer referenced is relative to where the process starts. For
instance, if this process started at 5 mm (Advanced tab setting), then the layer 1 command would take
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place at the first layer after 5 mm.
Blip fan to full power when increasing from idle: With small fans, there's very little torque. Meaning
the fans can sometimes not generate enough force to get moving, (once they're moving they're fine, but
getting started can be tough), this setting can help blip the voltage to the fan and get it running. For
instance, if you have Blip fan on and your PLA settings are:
PLA:
Layer 1- Fan off
Layer 2- Fan On 60%
The G-Code would be written to turn the fan on at 100% first (higher torque blip), then turn the fan to
60%.
;layer 2
Fan on 100%
Delay .5 seconds
Fan on 60%
Adjust Printing Speed for Layers below ___ Seconds, Allow speed reductions to %: This setting takes
effect for layers that would otherwise print too quickly. For instance, if you printing a pyramid as seen
below, you can see that the print speed lowers as the layers get smaller. You can see from the legend on
the side, that the dark blue is the slowest speed, it's because the Cooling Speed Overrides are slowing
this layer down dramatically because it would take far less than 15 seconds per layer.

Increase fan speed for layers below ___ Seconds, Maximum Cooling fan speed ___% This is similar to
the speed overrides above, but you would just be controlling fan speed. I personally have not used this
feature, as I typically like to print with either 0 or 100 % fan speed.
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Bridging fan speed override: For bridging it's important to get the material to solidify as fast as
possible, setting a fan speed for bridging only can help accomplish this. For the rest of the bridging
settings, see the Other tab.
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Tip of the Day 25 - Temperature tab, a technical analysis
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Posted: Thu Mar 26, 2015 1:53 pm
by KeyboardWarrior

Temperature Controller List: This is where you'll have your extruders and heated bed listed. If you need
to add an extruder/heated bed you would click the button for "Add Temperature Controller"
Temperature Identifier: The firmware identifier for this toolhead. Most printers use the notation for T0
for the Right Extruder and T1 for the Left Extruder. If you aren't 100% sure, you can open the Machine
Control Panel and use the temperature identifier selector in that screen to find out what toolhead is
which.
Temperature Controller Type: Sets whether your element is an extruder or heated bed. This makes a
difference in the G-Code used to control it. For instance, the RepRap commands for an extruder are
M104 and M109 whereas for a heated bed it's M140 and M190.
Relay Temperature between each: This will set how often to relay the temperature for USB prints.
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Per-Layer Temperature Settings: Allows you to set temperature on a per layer basis. The temperatures
that are set are read to the left. The adjustable numbers on the right do not effect your print, only when
you click "Add Setpoint" are the temperature commands entered in.
Also, if printing with multiple processes, the layer # chosen is relative to the process. For instance, if
this process applied from 5 mm to 10 mm on the model. The temperature for layer 1 would take place
at the first layer after 5 mm.
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Tip of the Day 26- G-Code tab, a technical analysis
http://www.forum.simplify3d.com/viewtopic.php?f=8&t=2366
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Posted: Thu Mar 26, 2015 2:19 pm
by KeyboardWarrior

5D firmware (include E-Dimensions): 5D firmware means that your printer supports X,Y,Z,Speed and
Extrusion amounts. Almost every printer currently on the market does, so this should remain checked
for 99% of printers.
Relative Extrusion Distances: The options for G-Code creation are absolute or relative extrusion
distances. For relative extrusion distances, each line would have an E-value that only applies for that
line, whereas for absolute extrusion distances the E-values stack up.
Relative Extrusion:
G1 X## Y## E2.5
G1 X## Y## E2.5
G1 X## Y## E2.5
G1 X## Y## E2.5
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Absolute Extrusion:
G1 X## Y## E2.5
G1 X## Y## E5
G1 X## Y## E7.5
G1 X## Y## E10
Allow zeroing of extrusion distances (i.e. G92 E0): When using Absolute extrusion mode, the printer
keeps a running virtual position of the extruder. Using the command G92 E0 can reset this virtual
position to zero, this command is in most the starting scripts for RepRap machines prior to and after
priming. Certain printers have firmware compatibility issues with this command and certain printers
(relative extrusion machines) don't need G92 E0 commands, so this command will vary from printer to
printer.
Use independent extruder axes: Certain firmwares (MakerBot/Sailfish) will track the extrusion rates of
printers individually, whereas RepRap printers will use a single running tally (not independent) for
extrusion rates.
Include M101/M102/M103 Commands: The tool-tip states that these are legacy commands and not
used by modern printers. In looking up these commands this was what I found they used to do (incase
your interested):
M101 Extruder on, fwd
M102 Extruder on, reverse
M103 Extruder off
Firmware supports "sticky" parameters: Sticky commands is a great way of preventing much larger Gcode files. The way to think of "sticky" commands is something won't change unless it's told to change.
If sticky commands were not supported, changing the X value and extruding
G1 X10 Y10 E1 F100;
G1 X20 Y10 E2 F100;
G1 X30 Y10 E3 F100;
G1 X40 Y10 E4 F100;
With Sticky Commands:
G1 X10 Y10 E1 F100;
G1 X20 E2;
G1 X30 E3;
G1 X40 E4;

G-Code Offsets: If your prints are off-centered or too high off your build-plate the G-Code offsets are a
great way to fix that. For instance, if your prints are 2 mm too high off your build plate, apply -2 mm in
the Z-axis. If your prints are 10 mm to the right, place -10 mm in the X-axis. You will see these shifts in
the G-Code previewer, but since these offsets are what works for your machine then that shouldn't be
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an issue!
Update Machine Definition using settings below: There are two ways to set the Machine Definition in
Simplify3D. Under Tools-->Options (Windows) or Simplify3D--->Preferences (Mac) and under the
FFF Settings window. If you set the Machine Definition under the Options window and then find that
it's being overwritten everytime you click on your process, that would mean that this option is enabled
and overwriting your build volume with different values.

Build Volume: This is pretty straight forward, the only time that it gets a bit tricky is with Delta style
printers. For a delta printer, take your diameter and multiply it by .707 (Since Simpliy3D measures the
largest square that will fit in your build-plate), you will still get to use your entire build volume when
printing, it just uses a different number when setting the build volume.
Origin Offset: If your origin is at the bottom left of your printer (RepRap), it would be 0,0,0. If your
origin is in the center of your machine (MakerBot/Sailfish and Delta printers) you take your build
volume # and divide by two to place the origin in the center of your build plate.
Homing Dir: This setting doesn't change the print instructions, but just changes the G-Code previewer.
You can set where your homing endstops are relative to your axis that way when Simplify3D has a G28
command (home all axis) it will know where the extruder gantry is.
Flip Build Axis: This is for the build area in Simplify3D, generally can leave this as default. If you
need to flip one of the axis relative to your origin for your printers configurations you can do so from
here.
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